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Overview 
This documentation is intended to show you how to edit your website using the CMSmadeeasy 

Content Management System.  A content management system refers to any software that you use to 

update and maintain content on your website.  In the Web Design industry, this term is commonly 

abbreviated ñCMSò and pronounced C-M-S. 

To access the CMS, you will need to use your Web browser.  The minimum browser requirements 

are: 

 Internet Explorer 7+ 

 Firefox 3+ 

 Google Chrome (any version) 

 Safari 3+ 

 Opera 9+ 

To determine which browser and version you are using, navigate to the Help menu of your browser 

and look for the About option.  If necessary, you can download any of the aforementioned browsers 

from their manufacturersô websites for free.  

OnLine Help 
We also have a wide variety of online videos and other documents to help you use CMSmadeeasy.  

Please see http://training.cmsmadeeasy.com   We strongly recommend you at least look at the 

Introductory Tutorial before you start - http://training.cmsmadeeasy.com/introtutorial.html 

Accounts & Authentication 

Logging in 
To access CMSmadeeasy at www.cmsmadeeasy.com/login, you will need to have your email address 

and password available.  If you have not yet received your password by now, contact us. 

 

Simply enter your email address in the Email field and your password in the Password field to login.  

Note that passwords are case sensitive.  Once you have entered this information, click Login. 

If you have forgotten your password, use the link below the form to receive a new one (we do not 

retain access to your password). 

http://training.cmsmadeeasy.com/
http://training.cmsmadeeasy.com/introtutorial.html
http://www.cmsmadeeasy.com/login
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If you enter the wrong details, you are directed to this screen, where you can try again: 

 

We now give you two more options: 

Setting your language preference 

You can select a different language by choosing one from the dropdown control.  Your 

preference will be saved only on the computer you are currently using.  If you use another 

computer, or if someone using your computer changes the language preference, you will need 

to set it again the next time you login. 

Once logged in, you can also change your language preference from within My Account > 

Preferences. 

Resetting Your Password 

If you have forgotten your password, select the Forgot Password link at the bottom of the 

login form.  You can reset your password by providing your email address and a 5-letter 

security code.  A new temporary password will be sent to your email address immediately. 

Once logged into the CMS, you can change your temporary password by going to My 

Account > Change Password. 

Once logged in, you are taken directly to your Webpages list.  If you are able to edit more than one 

website you are taken to the Websites first, so that you can select the website you wish to edit. 

Websites 
The Websites section is where you can view and select which website you would like to edit.  If you 

only have one website, you will be automatically taken to the Webpages section. 

Selecting your website 

For editors who have access to more than one website, you will see the following screen. 
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To select the website that you would like to work with, simply click on the appropriate domain name.  

For example, to edit a webpage under example-1.com, you would click on example-1.com. 

Webpages 
The webpages section displays each webpage that you are allowed to edit.  We can arrange it so that 

each editor for your site only has access to pre-defined webpages, instead of the whole site. 

 

Selecting a webpage 

To begin editing one of your webpages, select the appropriate label from the list.  For example above, 

if you wanted to edit your homepage, select the label ñHomepageò by clicking on it. 

You can VIEW  any webpage by clicking on the File Name. For example, to view the homepage, 

click on ñ/index.phpò in the above example. 
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Changing page labels 

You can change the label of each webpage by selecting the Edit Label option.  These labels are only 

used within the CMS to reference your pages, so feel free to use anything that helps you to remember 

which page is which. 

Once you select the Edit Label  option, a textbox will appear allowing you to change the label.  When 

you are finished editing, press Enter or click anywhere outside of the textbox to save your changes. 

Cloning webpages 

You can quickly and easily create new pages by cloning, or duplicating, existing pages.  When you 

clone a page, an exact copy of the page you are cloning will be created.  To clone a page, follow these 

steps: 

1. Select the Clone option. 

 

2. Enter a file name for the new file that you are creating. It is usually best to use lowercase 

characters and dashes for webpage filenames.  The CMS will automatically turn spaces into 

dashes for usability purposes. 

3. Click the Create New Webpage button. 

4. The new page will be displayed below the existing page and you will automatically be asked 

to change the page label. 

 

Once your new page is created, be sure to update the webpage title, description, and keywords to 

ensure that search engines index it properly.  Refer to the Page Properties section for more 

information about this feature.  

(If you create a new page, it must be linked to from an existing page if you want users to find it.) 

Note: Depending on your account settings, the clone feature may not be available. 

Deleting webpages 

You can remove old or unwanted pages by selecting the Delete option.  You will be prompted to 

confirm your choice.  Click Delete to permanently delete the webpage, or Cancel to abort the 

operation. 
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Note: Depending on your account settings, the delete feature may not be available. 

Webpage Editor 
When you start to edit a page, you will see a screen similar to this with your page details on it. 

 

We will discuss editing first.  The Page Properties and Page History are discussed later. 

Selecting a content region 

Although each webpage will vary, it is possible for your pages to have multiple content regions.  A 

Content Region is simply a section of your webpage which has been designated as editable.  If your 

pages have more than one content region, you can switch between them using the Content Toolbar: 
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Each button on the Content Toolbar represents a unique content region; each region is given a name 

loosely representing the contents of that region.  To select one of the content regions, simply click on 

the appropriate button in the toolbar.  You can switch back and forth between content regions on the 

same page without having to save your changes. 

Types of content regions 

Video Training at http://training.cmsmadeeasy.com/editing-content-regions.html 

There are a handful of different types of content regions available in the CMS.  The most common is 

the rich-text editor which usually contains a text region (often with embedded images), but depending 

on how your website was setup, you may come across any of the following: 

Rich-text  

This is the default content region type.  See the Rich-text editor section below for more details. 

Headings 

This type of content region only allows you to change the text in a heading (H1, H2, H3, H4, H5, H6). 

Images  

This type of content region allows you to edit a single image.  You can edit the image, upload a new 

one, or change the image description. 

Plain-text 

This type of content region only allows you to use plain-text. 

Source code 

This type of content region is for advanced users who need to work with CSS, JavaScript, or XML 

files. 

You can tell the Content Region type from the icon in the tab. 

Advanced Users 
There are some features in CMSmadeeasy which require some knowledge about how websites work 

or how the browser interprets certain functions.  On several of the sub-editors (e.g. the Image Editor 

or the Multi-media insert option) you will see a ñPopupò , ñEventsò or ñAdvancedò tabs. 

Some of the options here are self-evident and some will require more specialist knowledge.  Donôt 

worry if you do not immediately grasp how to use the advanced features. 

 

The rich-text editor 
You will likely spend most of your time editing your website using the rich-text editor.  The 

following is a screenshot of the rich-text editor with all options enabled.  Your version of the editor 

may be simplified depending on your account settings (set by CMSmadeeasy). 

http://training.cmsmadeeasy.com/editing-content-regions.html
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Working with the rich-text editor is very similar to working with popular word processing 

applications.  The following sections will go over some of the basics as well as some of the more 

advanced features, such as structuring your content, creating hyperlinks, and working with images 

within the rich-text content region. 

We will describe the function of the various ñbuttonsò or ñiconsò in the editing menu bar: 

 

Undo & Redo 

 

The undo and redo buttons allow you to step through your changes while editing.  

Basic formatting 

 

As in many popular word processing applications, you can change the format of text by selecting one 

or more characters and clicking on the appropriate formatting option.  For example, to make text bold, 

select the appropriate text and click on the B in the toolbar.  Similarly, to make text italic, select the 

appropriate text and click on the I in the toolbar.  Depending on your account settings, you can also 

choose underline, strikethrough, subscript, and 
superscript

. 
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A note about using underlined text on webpages:  Most users expect underlined text on webpages 

to be hyperlinks.  Therefore, it is generally considered a bad practice to use such formatting on 

webpages, as it could easily confuse users and make them think your website is ñbrokenò because 

your ñlinksò do not seem work. 

Text Alignment 

 

You can choose to align your text left, center, right , or justified  using the respective buttons in the 

rich-text editor toolbar.  To do this, click inside of a paragraph (or highlight multiple paragraphs) and 

select the appropriate option from the toolbar. 

Structuring Your Content 

The Format dropdown allows you to structure your document using 

paragraphs, headings, and other types of content sections.  These content 

sections help keep your webpages organised.  Since search engines deliver 

results based on relevancy, it is important to structure your webpages properly 

and use these content sections properly whenever possible, especially headings. 

The default type of content section is paragraph.  You can create a heading by 

selecting a line of text and choosing one of the heading options from the 

Format dropdown.  To turn a heading back into a paragraph, select the 

appropriate text and choose Paragraph from the Format dropdown. 

For best results, refrain from using Headings strictly for style.  For example, if you want to emphasize 

a sentence it is usually not a good idea to do so by making it a Heading 1. (Itôs not a good idea, 

because Search Engines often use H1 to recognise the SINGLE most important sentence in your text.)  

See the section on Custom Styles or Text Formatting  or more information on how to properly 

format text. 

Text Formatting 

 

To change the appearance of text, including the font size, foreground, and background colour, you can 

use the following toolbar options.  Simply select the text that you would like to format and choose the 

appropriate size and colours.  

Custom Styles 

Your original web-designer may have used custom styles when developing the 

website.  If these styles are available, you will find them under the Styles dropdown. 

These styles will vary in both name and appearance, depending on how your 

designer has configured them.  If they are available to you, you can apply one or 

more styles to your content by selecting some text, clicking the Styles dropdown, 

and choosing the style you want.  To apply multiple styles to the same content, select 

each style from the Styles dropdown one at a time. 










































